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. Veeda Clinical Research Limited (“Veeda”) together with its subsidiary, Bioneeds India Private Limited
(“Bioneeds”), and its joint venture, Ingenuity Biosciences Private Limited (“Ingenuity”), (together referred to as the
“Veeda Group”) offers a comprehensive portfolio of clinical, preclinical and bio/analytical services to support
innovator, biosimilar and generic drug development programs of our global clientele

. We are an independent, institutional investors owned, Board governed and professionally managed contract
research group offering scientific leadership, global quality management systems and long term operational and
financial stability through a continuing investment in our people, processes, systems, infrastructure and technology
and a deep commitment to quality

. Together, we serve clients globally in the following industries:
— Pharmaceutical and Biopharmaceutical
— Agrochemical and Industrial Chemicals
—  Herbal/Nutraceuticals
— Medical Devices
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. Veeda’s Current Geographical
Presence

Veeda’s Team Presence
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Vision Mission

In an industry where innovation is increasingly To be the pre eminent independent Indian contract
multifaceted and collaborative, we aspire to be research Organization, with global execution capabilities,
the research partner of choice for innovative distinguished by the breadth of our services and by
(bio)pharmaceutical companies worldwide for excellence in the quality of our Scientific and regulatory
their critical product development programs knowledge Research design, execution and insights and

/ Client centricity /
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Quality Framework R

Inggnuity

“Our management is committed to continuous improvement in the effectiveness of our

Quality culture, to providing quality research solutions that meet sponsor and regulatory Balanced Score Cards (BSC)
requirements and to protecting the rights, safety and well being of the study volunteers” IE
5

T

for augmenting corporate
strategy

Quality @ ~=+'  Quantifiable Performance
Policy = Comprehensive system with more - DI] Metrics for all departments
than 350 SOPs
Quality * QC & QA monitoring
Management v lity Review Meet - B
System S R AN G TR =y“  Individual KPI's & KRA’s
= CAPA Management . & - linked to BSC
Quality Culture
.& Continuous process
: : i i : : ' improvement
Focus on implementing policies & nurturing individual behavior to sustain our &&,&

culture of quality
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» 82 successful regulatory audits till date
* 09 successful regulatory audits in last 24 months

USFDA ===  34* ANSM s 1

MHRA ndi AGES  w=m 1

ANVISA ndE MCC == 1

WHO i ) DCG| 18

NPRA

Malaysia - S *FDA : 17 AUDITS FOR PATIENT BASED STUDIES

17 AUDITS FOR HEALTHY SUBJECTS STUDIES

i ! . .
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Humility Innovation Accountability

I

l l

Integrity Excellence Collaboration Nurturing
Individual Growth
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Drug Development
Services Overview
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Drug Analytical Preclinical Phase | to Phase IV BA/BE Small Molecule
Discovery Characterisation Research Clinical Trials (Healthy Bioanalysis

for Biosimilar & Development & Patient)
- Hit 1o 1 - Studies

@ Bioneeds Ingenuity @ Veeda

Large Molecule Bioanalysis
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Early to Late Phase
Clinical Trials
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Infrastructure

VEDANT

Clinical,
Bio-analytical facility

SHIVALIK

Dedicated Clinical
facility

SKYLAR

Common screening
facility for both Shivalik
and Vedant

ARCHIVES

+ MAGNET
CORPORATE PARK

Administrative
office

« MEHSANA

Clinical and
Screening facility

* INSIGNIA

Dedicated
Bio-analytical facility

Internal archival area in each facility.
Separate long term archival facility at

Changodar and Unjha

Partners in creating a healthier tomorrow

e d

Veeda s wenn, 3IBIONEEDS Ingenuity

Spread across 14 clinics

Shivalik &——— Vedant

170 Beds + 593 228 Betsy

7 Special care beds + Beds 6 Special care beds +
12 Intensively monitored + 20 Special care 18 Intensively monitored

beds to conduct Phase | beds beds to conduct Phase |
study study

Mehsana
162 Beds +

[ Special care beds
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Clinical Trials
Overview
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Clinical Trial U L A—

Medical Writing

SerV| Ces - Protc:(é?l, ICF,

Study Report etc.
Conducting
Feasibility &

Site Set up

Safety o
activity

Database and
Pharmacovigilance

Clinical
Trl al Regulatory Services

. Application processing
Data _mangggment, Serv | Ces Technic_al pres_,entation
Biostatistics -Liasioning
including
eCRF capabilities

Site Monitoring,
Pharmacy and Project
Laboratory service Management
including PK and &Safety
Immunogenicity Monitoring,
analysis capabilities

Partners in creating a healthier tomorrow
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Clinical Trials Experience
And Capabilities
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Diverse Therapeutic Areas Of Expertise

Cardiology

Ophthalmology

ENT

Respiratory

Rheumatology

@Y@ Gynecology

Oncology

Endocrinology

Partners in creating a healthier tomorrow
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Dermatology

Gastroenterology

Psychiatry




Deep expertise for Patient PK o ®.  soos é

end point studies

Therapeu_tlc Areas ke No. of Studies No. of Patients Type of Study
Indications

HIV 1 48 PK Endpoint Study
Oncology (22 studies)
Chronic Myeloid Leukemia (CML) 6 160 PK Endpoint Study

CML & Gastrointestinal stomal
tumor (GIST)

Metastatic Breast Cancer (MBC) 3 203 PK Endpoint Study
Metastatic Breast Cancer (MBC)

1 40 PK Endpoint Study

and Colo Rectal Cancer (CRC) 2 9 PK Endpoint Study
Multiple Myeloma (MM) 1 54 PK Endpoint Study
Orthopaedic Cancer 1 58 PK Endpoint Study
Ovarian Cancer 2 120 PK Endpoint Study
Ovarian and MBC 3 202 PK Endpoint Study
Renal Cell Carcinoma (RCC) 3 86 PK Endpoint Study
Schizophrenia 7 463 PK Endpoint Study
Rheumatoid Arthritis (RA) and 1 1 R sl ey

Psoriasis

Partners in creating a healthier tomorrow
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Experience

Therapeutic Area Completed Studies Study Phase

Oncology 6 Phase 1, Phase2
Orthopaedic 3 Phase 3
Ophthalmology 1 Bioequivalence Clinical Endpoint

Partners in creating a healthier tomorrow
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Ongoing Patient Trial Studies veedo. o, 3BONEEDS  ingenuity

Phase I/l

Pk end point
Pk end point

Phase I

Pk End Point
Clinical End Point
Phase |
Pk End Point
Pk End Point
Phase II/lll

Acute ST segment

Thrombolytic
Elevation Myocardial Infarction
Oncology Breast Cancer
Oncology Advance prostatic cancer
COVID-19 mildly symptomatic patients with SARS-CoV-2
Infection (Covid-19)
Oncology Ovarian Cancer
Ophthalmic open-angle glaucoma or ocular hypertension
Oncology Solid Tumor
Hematology Iron Deficiency Anemia
Oncology Breast Cancer
COVID-19 SARS-CoV-2 Infection in healthy subject

Partners in creating a healthier tomorrow
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Completed Projects é

. . Recruitment timelines
Study detail Submission _ Comments
Committed Actual

Etoposide 50 mg capsule — Sample size-24

scLC US FDA 7 months 4 months NO of sites-8

Imatinib 400 mg tablet — CML US FDA 4.5 months 4 months SEE R
No of sites-4

Capcitabine 500mg Cap in Sample size — 54
MBC and CRC EU 3.0 months 3.0 Months No. sites — 8

Methotrexate 2.5 mg Tab in Sample size — 42
RA & Psoariasis US FDA 4.5 months 2.0 Months No. sites — 10

Everolimus 10 mg tab — RCC US FDA 3.5 months 3 months SEIMPE S ele

No. of sites -25

Doxorubicin Hcl (Pegylated Sample size- 58

14 patients in one

liposomal) Ovarian & Breast EU 3 months No. of Sites - 12
month . .
Ca. The study was discontinued by the sponsor
Doxorubicin Hcl (Pegylated S,\?(;ngzif:s?ﬁs
liposomal) Ovarian & Breast EU 4 months 4.25 months

The second study was repeat study of above

Ca. discontinued study

. Partners in creating a healthier tomorrow
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Submissio Recrwtment timelines
Study detail - Comments
Imatinib 400 mg tab CML US FDA 3.5 months 1.2 months SEME §|ze-32
No of sites-4
Imatinib 400 mg tab CML US FDA 3.5 months 1.5 months SEIHE SZE L
No of sites-4
Imatinib 400 mg tab CML US FDA 3.0 months 2.0 months SEME glze-SO
No of sites-4
Quet_laplne_400 mg I_ER tab EU 3.5 months 2 5 months Sample_5|ze — 64
in Schizophrenia No. sites — 4
Imatinib 400 mg tab CML US FDA 4.5 months 4 months SEME §|ze-32
No of sites-4
Sample size 32. 1.Planned with 2
indications. GIST and CML. Just prior to
o recruitment it was decided to recruit only
Imatinib 400 mg tab CML EU 4.5 months 6.5 months CML patients.

1.Planned in 8 sites but 4 sites did not
recruit at all.

Partners in creating a healthier tomorrow



Completed Pro

Nevirapine Tab 400 mg
HIV-1

Paliperidone PR 9 mg tab,
Schizophrenia

Clozapine Tab 100 mg,
Schizophrenia

Clozapine Tab 25 mg,
Schizophrenia

Imatinib 400 mg tab — CML &
GIST

Paclitaxel 100 mg/vial
MBC

Everolimus 10 mg tab — RCC

Quetiapine 600 mg PR tab in
Schizophrenia

jects

EU 3.5 months 2.5 months
EU 3.5 months 2 months
USFDA 2 months 1 month
CFDA 1.5 months 0.5 month
US FDA 3 months 2 months
US FDA 4 months 4.5 months
US FDA 3.5 months 4 months
EU 3.5 months 3.0 months

. Partners in creating a healthier tomorrow
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Sample size — 48
No. of Sites 4

Sample size — 75
No. of Sites 5

Sample size — 28
No. of Sites 2
Sample size — 14
No. of Sites 1
Sample size-40
No of sites-4
Sample size- 76
No of sites-15
Sample size- 30
No. of sites -15
Sample size — 52
No. sites—3



Completed Projects é

Sample size — 108 (randomize)
No. sites — 7

Risperidone LA Injection 25 3.5 months 4.5 months (108
mg in Schizophrenia EU (200 ' domized Note: Due to Investigator’s decision to
randomized) randomized) withdraw from the trial due to administrative
issues at the site, patients were withdrawn
at that site and additional patients were
randomized from other sites.

Capecitabine Tablets 500 mg Sample size: 45

in MBC and CRC U (HB2  GISTTES Eeb TS No. of sites: 6
Liposomal doxorubicin
Injectable 1V infusion in US FDA 8 months 8 months Sample Size — 66
ovarian cancer No. of site — 14

Liposomal doxorubicin
Injectable IV infusion in EU 8 months 6 months
ovarian cancer and MBC

Sample Size — 79
No. of site — 15

Partners in creating a healthier tomorrow



Completed Projects

Liposomal doxorubicin

Injectable 1V infusion in USFDA 10 months 9 months SENPID Sl — oA
. No. of site — 15
ovarian cancer
Bortezomib in Multiple USEDA 10 months 10 months Sample Slze - 54
Myloma No. of site — 15
Leuprolide in Patients with . Sample Size — 32
RCC Pilot Study 06 months 4.5 months No. of site — 10
Rlspen_done 2_5 mg Inj _Patlent EU 08 Months 08 Months Sample S_lze - 122
with schizophrenia No. of site — 10
Capecitabine 500 mg tablets Sample Size — 51
in Patient with MBC USFDA 06 Months 05 Months No. of site — 9
Paclitaxel 500 mg tablets in Sample Size — 76
Patient with MBC USFDA 08 Months 08 Months No. of site — 9

Partners in creating a healthier tomorrow



Completed Phase Il & Ill Projects é
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Subjects

Therapeutic Indication Therapeutic Areas

randomized

1 A Phase Il Study in Non-Small Cell Lung Cancer- Oncology 53

A Phase | Followed by a Randomized, Phase Il Study in Small
2 Oncology 5
Cell Lung Cancer (SCLC)

Phase Il clinical study in non-small cell lung cancer and
3 Oncology 40
colorectal cancer

4 Phase 2b Study in Advanced Non-Small Cell Lung Cancer Oncology 26
Phase Ill Study in Subjects with Articular _

5 Orthopedic 14

6 Bioequivalence with Clinical End Point Ophthalmology 200

Partners in creating a healthier tomorrow



Completed Phase Il & Il Projects

Subjects

Therapeutic Indication Therapeutic Area _
randomized

©

Inggnuity

Phase Il study of Inhibitor of PD-L1, PD-L2, and VISTA
7 - Oncology 130
pathways in Different tumor types (5 cohorts)

8 CA-170 Oncology 62
9 Cartilage Defects of the Articulating Joint(s) Orthopedic 14
10 Phase IIl Study in Subjects with Avascular Necrosis (AVN) Orthopedic 14
11 Bioequivalence with Clinical End Point Ophthalmology 200

Partners in creating a healthier tomorrow



Current Projects Patient Based PK b smouess é
Studies

Liposomal doxorubicin Injectable Sites-18*/15, N-103*/51

IV infusion SISl *Recruitment completed OIEEN LIS
Bortezomib s.c. 3.5 mg/vial USFDA 15 sites; Subjects — 40 (evaluable) Multiple myeloma 1
Paclitaxel Protein Bound Particles ;g ¢y, 15 sites; Subjects — 32 CRC 1
for injectable suspension
Clozapine 100mg tablet US FDA 2 sites; Subjects — 12(evaluable) Schizophrenia 1

Leuprolide acetate lyophilisate
powder ANVISA 15 Sites; Subjects — 200 (evaluable) Endometriosis 1
for injectable suspension 3.75 mg

5 Sites; Subjects — 140 (evaluable)

Amphotericin B 50mg/vial USFDA Infectious disease 1

Paliperidone palmitate 156 mg

injectable suspension (LAI) EU Sites- 10, Subjects — 130 (evaluable) Schizophrenia 1

Partners in creating a healthier tomorrow



Veeda’s Investigator & Site Database é’

Therapeutic Area Investigators Database No. of sites Veeda worked with

Oncology 150 Oncologists 90 sites
Psychiatry 90 Psychiatrists 35 sites
Orthopedics and Rhuematology 72 Orthopedics and Rheumatologists 25 sites
Infectious Disease 79 MD Physicians 25 sites
Dermatology 87 Dermatologists 40 sites
Cardiology 20 Cardiologists 35 sites
Ophthalmology 90 Ophthalmologists 40 sites
Urologist 27 Urologists 12 sites
Nephrology 66 Nephrologists 15 sites
Pulmonology 80 Pulmonologists 40 sites
Gastroenterology 45 Gastroenterologists 10 sites
Endocrinology 38 Endocrinologists 20 sites
Hematology 16 Hematologists 15 sites
ENT 35 ENT Specialists 10 sites
Gynaecology-Obs 70 Gynecologists 20 sites

Database of more than 900 Investigators, Veeda team has worked with more than 300+ Clinical Research Investigators.

Partners in creating a healthier tomorrow



Services offered — Site Network eeds. o, 3BONEEDS é

g % —
e \IM% \& j’il/;;?\ Sites across all major cities
¢ i
. C?‘j, . NE‘“M}@AE’V:} /;,” : More than 150 active sites
A &WLU‘\ C o /
fs ;!\r‘_‘s: vl}\ o ar
[

N ¥ f \ 3 currently
N ¢ ; e ’ CRAs based in > 6 citi
. &y w«r{ - > s based in > 6 cities.

-r 5 ‘r ,Z, 17 sites audited by regulatory
\ .,_4"? .
7

. J* ) agencies
-
'{. 5; \,f & Actve Sies
\K ;?r—” _)) Potentlial Slies
\\“Tf f Pﬂmmnal CRAS
\k{ L
g
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Board of Directors

Managing Director

Vice President

Head - Clinical Operations

Sr. Project Manager PM

(03) (04)
Sr. CR CRA CTA
(03) (26) (15)

Partners in creating a healthier tomorrow
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Team Overview - Clinical R
Operations - Organogram

7~ N\
Managing
Director
Regulatory and Bio- - 3 . Vice President — Clinical g
pharmaceutics Bio-analytical Services Operations Quality Assurance Data management
Study Design &
Feasibility Evaluation Project Management Medical Monitoring
(Medical Writing)
/—\
PMs, CTLs, CRAs, CTAs
N

Partners in creating a healthier tomorrow
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Combined Team Experience L —

In Clinical Trials

75 patient based
PK clinical trials

More than 300 clinical trials

that includes Around 175

Phase Il & Phase llI
clinical trials (including

5 NCE & Biosimilar)
Around 50 clinical

endpoint studies

Partners in creating a healthier tomorrow



Team Experience Across various R ]
Therapeutic Areas and Indications

Psychiatry Major Depressive Disorder, Schizophrenia, Bipolar disorder, Bipolar | depression USFDA, EMA and DCGI
2 Medical Devices CAD, Arrhythmia, Heart failure, Uncontrolled hypertensions, USFDA & DCGI
3 Cardiology Hypertension, Ischemic cardiomyopathy, CVD, ACS USFDA, EMA and DCGI
4 Endocrinology DM-I, DM-II, Diabetic nephropathy USFDA, EMA and DCGI

Advanced Ovarian Cancer, Metastatic breast cancer, Renal Cell Carcinoma, Multiple Myeloma,

9 Oneeley; Colorectal Cancer, Solid Tumors / Lymphoma, NSCLC, Cervix Cancer, ARy (2, R Et DO
6 Respiratory Asthma, COPD USFDA & DCGI

7 Dermatology Atopic dermatisis, Oral lichen planus, Dermatomycoses DCGI

8 Nephrology CKD, Urinary tract infection and pyelonephritis USFDA & DCGI

9 Gastroenterology Arsenic Poisoning, GERD, Constipation, Ulcerative Colitis USFDA & DCGI

10 Infectious diseases Bacterial Infection, Skin Infection, Hepatitis B Infection USFDA & DCGI

11 Ophthalmology Chronic Open Angle Glaucoma, Ocular Hypertension USFDA & DCGI

12 Neurology Epilepsy, Seizures DCGI

13 Vaccine Rabies, Leishmaniasis & serious fungal infections DCGI

14 Orthopaedic Psoriasis and Rheumatoid Arthritis& Osteoporosis USFDA & DCGI

Partners in creating a healthier tomorrow
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People

« 12 Continuous Professional Development (CPD)
program topics/year/department

» Dedicated Training Team and Learning

Management System
* Refresher training conducted every year

« eModules Training done through iPads

J

m20CRA m8PM's m30Contractual =16 CTA's
Phlebotomists

 GCP/GLP training conducted externally once every

year SOP training conducted on an ongoing basis

Partners in creating a healthier tomorrow
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Antiviral Rheumatology

Recruitment Months -Actual _ Recruitment Months -Actual _

0 1 2 3 4 5
0 0.5 1 15 2 2.5 3 3.5 4
Psychiatry
Study 7
SO
SOy ———————————— S
Study 4 e —
Study D e —
SO\l
OOy F———
0 1 2 3 4 5 6 7 8 9

B Recruitment timelines -Actual B Recruitment timelines -Committed

Partners in creating a healthier tomorrow



Meeting Recruitment Timelines ecta® b, 3BONEEDS  ingemaiy

12

1010
10

10
9
88 8 8 8
7
6.5
6 6 6
5.5
45 45 4 45 3 E
4 "4 4425 . B 4 4 4 '
35 SISH- 3,
33 3 3 3
2 2
L, s
0

Study 1Study 2Study 3Study 4Study 5Study 6Study 7Study 8Study 9 Study Study Study Study Study Study Study Study Study Study Study Study
10 11 12 13 14 15 16 17 18 19 20 21

)]

IS

N

B Recruitment Months - Committed B Recruitment Months - Actual
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Pre-study activies- Project Plans

Project Management Plan

Data Management Plan & Data
Validation Plan (Data entry and
system Validation)

« Edit check Plan (Checking Edits
in CRFs)

Communication Plan

Lab Data Transfer Plan

Site Monitoring Plan

Risk Management Plan
(Identified Risk & Mitigation)

Investigational Product Plan &
IMP Manual

Quality Plan

vo ®

veeda - #BIONEEDS Ingenuity

Bio Analysis Plan PK sample handling Plan

Medical Monitoring Plan — MMP Safety Management Plan

Working Instructions and Site
Operations Manual for sites

= Qur project team ensures development of comprehensive project plans to successfully
manage triple constraints of projects — cost, time and resources.

I

Partners in creating a healthier tomorrow



Our Monitoring Approach é

Monitoring Assumptions

Monitoring Frequency In process Monitoring Remote Monitoring
» During Recruitment & Treatment — 1 » 8 hron site during 15t dosing * During Lockdown or Curfew
/month + Key parameters to be focused * rSDV platform

* Multiple CRASs visits

* In house support to CRAs
« 100% SDV

» Sponsor reviewed report
* QC oversight

Key parameters to be focused

Clinical Monitoring Objectives

= ICF review = Safety review = Study Product management

= Eligibility verifications = Site staff training = Non-compliance management
= Source data file review = Communication with site staff (if any)

= Laboratory data review = Site file review

Partners in creating a healthier tomorrow



Our Approach Handling weio® 2, smonens é

Patient PK studies

mmmmal EXperienced and Well trained Phlebotomist team:

* Network of contractual phlebotomist. Having average experience of 05 -06 years.
» Trained on GCP, GDP, Study protocol and PK sample handling manual.

» Phlebotomist represent part of site team and are delegated in the log.

» They are contractual and are responsible for sample collection and processing.

Ensure sites have adequate infrastructure and well trained

+ SIV Kits to sites.
+ Site Training.

mmmmal Timely Shipment

* Regular follow up with sites for tracking patient visit and to track PK sample storage conditions.
» Established vendor support to arrange the shipment of IMP to sites and to arrange the PK sample
shipment from sites to Veeda Facility.

Partners in creating a healthier tomorrow




CTMS

One centralized database
for all study data

Track study budget &
passthrough budget I

Gain complete

Real-time visibility into study control over your

milestones & metrics clinical trial
operations:
Integrated IP I

Inventory tracking

Automated email
alerts/naotifications

VERdd wus wenn, 3IBIONEEDS

Automate investigator
payments

Streamline
monitoring visits

Maintain electronic
Trial Master File (eTMF)

Inggnuity

Partners in creating a healthier tomorrow



CTMS - Key Features

Monitor Site Recruitment:
Real-time metrics and visibility to site
recruitment performance enables
earlier corrective action, if needed

Automated Alerts:
Configurable automated
alerts enable proactive
monitoring and follow up

Robust reporting capability:

Interactive reporting feature allows users to
report on trial data promptly and
stakeholders can take effective decisions to
ensure timely completion of study

e ® L
veeda . +BIONEEDS Ingenuity

Site Monitoring:

Plan site visits, track action items and open
issues, and submit monitoring report
(workflow enabled)

CRA Visit Calendar:
Allows CRAs and Project
Managers to plan their site
visits effectively.

Study Contacts
Database:
Centralized repository
of study contacts

Partners in creating a healthier tomorrow
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Electronic Data Capture

Capture, manage and report clinical trial data securely:

Web-based Capture data faster Online validation Streamline
and mobile- and more at the point of monitoring visits
enabled accurately data entry
Integrated Query Integrate medical Automated 21 CFR Part 11
Management dictionary (MedDRA, alerts/ compliant, maintains
WHO..) notifications complete audit trail

Partners in creating a healthier tomorrow
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Clinical Data Management veedasticn 30IONE

» Data Management Plan
Study » Database Design
Setup > Data Management Guidelines
» CDISC Compliance
» CRF Data Review
Data > DCF
Review » Lab Data Review
» Medical Coding
» Data Management Plan
Data » Database Design
Processing » Data Management Guidelines
» CDISC Compliance
Electronic File > Data Transfer to Sponsor
Management » Study Document Management

Partners in creating a healthier tomorrow



RemOte Source B Data Verlflcatlon veeda . #BIONEEDS  Ingenuity

(rSDV)

Connects Sponsors / CROs to Sitesfor:
* Remote Access

* Remote Monitoring

» Source Data Review/Verification

Purpose-built system includes capabilities:
* View documents

» Share comments

+ Assign tasks and review response

Compliant with Regulatory requirements:
* 21 CFR Part 11
* HIPAA

Cloud Based

* High Security

» Scalable

* Role-based access to data

Partners in creating a healthier tomorrow
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Configurable document review workflow

Deploy as a standalone portal or Upload scanned and redacted along with integrated collaborate feedback
integrated with Octalsoft eClinical documents. Site Administrator retains mechanism
Platform control of their documents
DOCUMENT REVIEW
FLEXIBLE DEPLOYMENT UPLOAD DOCUMENTS WORKFLOW
OPTIONS SECURELY
W
STANDARDIZE CONTROLLED REPORTS AND
DOCUMENT FOLDERS DOCUMENT ACCESS DASHBOARDS
Standardize Document Folder Permission based controls to limit Management reports and
structure across sites enabling easy document visibility and functional dashboards provide insight
access and review of source capabilities into real-time progress at site
documents

Partners in creating a healthier tomorrow




P ..
"

rSDV = Process FIOW veeda 3BIONEEDS

STEP 01
Site User Collects Source Documents

STEP 05

Site User addresses Site

Monitor’s comments, if any
STEP 04 AP 03

Site Monitor reviews source Site User uploads redacted
documents documents on rSDV Portal

STEP 02

Site User scans & redacts
source documents

Partners in creating a healthier tomorrow
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Study specific Quality ‘ PM review issue ‘ Ongoing Protocol
Management Plan : I escalations : I Deviation Analysis

Proactive Quality and Compliance Control
A,  A—

v' Sponsor and CRO Processes, CRA Resource: Site Education:
aligned v" GCP Trained CRAs v" GCP training
v Egﬁ”ed Quality Management v’ Study specific training for CRAs v Protocol training during IM, SIV
v' Mandatory protocol training with v' Ongoing training at IMVs

knowledge assessment v Tools, aids provided

v' Accompanied site visit by PM, as
needed

v TMF review

Partners in creating a healthier tomorrow
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Quality Assurance

Site Audits

+  Conduction of site audit as per audit plan
+ Complacence of QA audit

* QA audit of 100% site data (Including source data, CRF and Site files)
*  Main objective of audit will be to ensure Protocol adherence, meeting SOPs and regulatory requirements and to ensure

traceability of study conduct.

Focus during QA audits

» Safety of subjects (Have all the adverse events been promptly documented)

* Reporting of AE/SAEs to IRB, Regulatory and sponsor

» Regulatory aspects of the trial such as regulatory and IRB/IEC approval

* Protocol Compliance (including inclusion and exclusion criteria check)

» Availability of current version of all essential documents (such as Protocol, ICD, e-CRF completion guidelines etc.)
* Review of study team training and experience.

* Overall GCP and applicable Regulatory Requirements Compliance

Partners in creating a healthier tomorrow
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Executive Profiles
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Dr. Kiran Marthak, M.D. F.C.C.P. T.D.D. Director- S L A— gé

Medical and Regulatory Affairs

Current Responsibility

* Safety of the subjects, protocol designing,
*  Business Development of NCEs and the Clinical Trials with NCEs
* Liaison with Regulatory authorities

Profile Overview ( Career and Education)
*  Post graduate in Internal Medicine
*  Fellow of Faculty of Pharmacology University of London, U.K.
*  Fellow of American College of Clinical Pharmacology. Chairman of ISBEC- Ethics Committee
*  Senior management positions in Novartis, Pfizer, GSK, Ranbaxy and Member of Board of Director in Lambda Therapeutic
Research Ltd.
*  Faculty in Academic Institutions, invited speakers in International and National conferences

Experience :
*  Total Industrial experience of more than 40 years

Special Areas of Expertise:
*  Managed more than 25 Phase-1 studies, Expertise in dealing with Drug Discovery and Development, expertise in
International Regulatory affairs mainly related to Drug Discovery programs.

Partners in creating a healthier tomorrow
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Dr. Sumit Arora, M.D., Vice President - Clinical d gé'
Operations and MPD |

Current Responsibility

*  Clinical Operations
*  Medical Affairs
*  Pharmacovigilance

Profile Overview
. Sumit Arora is a physician with specialization in Clinical Pharmacology with over 18 years of experience in the field of Medical Affairs
and Clinical Research. He is currently assigned the responsibility of managing the teams in Clinical Operations, Medical Affairs and
Pharmacovigilance departments.

Experience
. His experience includes working in both Pharmaceutical companies and Contract Research Organizations like Dabur, Ranbaxy, PAREXEL,
Lotus Labs (subsidiary of Allergan, US; Actavis, now Teva) and Lambda Therapeutic Research before joining Veeda Clinical Research.

Special Areas of Expertise
. During his tenures, he has developed and led teams involved in clinical operations (project management, onsite and remote moritoring
teams involved in Phase II-IV clinical studies involving NCE, patient PK and clinical endpoint studies) , medical affairs, medical
monitoring, central/remote monitoring, pharmacovigilance. He has been a Medical Advisor for new product development, medical
rationales for new formulations and has formulated strategies for launches and promotion of new and existing brands

Partners in creating a healthier tomorrow



Dr. Ashutosh Jani, Ph.D. (Pharmacology), IR L. gé’
Head- Clinical Operations |

-

Profile Overview

uity

Current Responsibility

To Provide Strategic and Managerial Oversight for all Clinical Operations functions.
Organize and Implement Operational Strategies for Clinical Operations.
*  Ensure effective stake holder management.

Pharmacy Professional with Doctorate in Pharmacology and over 17 years of experience in the field of Clinical Research

Experience

Ashutosh has experience working in Academia, Pharmaceutical companies and Contract Research Organizations like Claris,
Acutest Research, Lambda Therapeutic Research before joining Veeda Clinical Research. During his tenures, he has managed
teams involved in Clinical operations & BD and is having good rich experience in Clinical Development, Project management,

contract negotiations, Implementation of programs in Therapeutic Areas like Oncology, Psychiatry, Endocrinology and
Inflammatory disease including multiple rare and complex indications.

Special Areas of Expertise

Patient based Pharmacokinetic studies for Precision Medicine, 505/b2, NCE, biologics & complex generics in Oncology and
Psychiatry.

Partners in creating a healthier tomorrow



Dr. Ravi Alamchandani, M.D., GM- weeda v 3BONEEDS  ingenuity
Medical Affairs & PV

"

Current Responsibility

*  To Provide Strategic and Managerial Oversight for all Medical Monitoring & Medical Writing
activities
*  To Support Safety Reporting and Pharmacovigilance Activities

Profile Overview
*  Dr Ravi Alamchandani is MD Pharmacology (Gold Medalist) with over 6 years of experience in the field of Medical Affairs and
Safety Reporting.
Experience
*  His experience includes working in Hospital, Pharmaceutical companies and Contract Research Organizations like DDMM Heart
Institute, Torrent Pharmaceuticals ltd., Lambda Therapeutic Research Ltd., before joining Veeda Clinical Research. He is
currently associated with Veeda Clinical Research as DGM— MPD and is leading Medical Monitoring, Medical Writing and
Pharmacovigilance team.
Special Areas of Expertise
*  Dr. Ravi has been involved in and managed teams involved in medical monitoring, medical writing and safety reporting
activities of Phase I-IV clinical studies (Efficacy studies, Patient PK studies including SAD & MAD studies and BE with Clinical
endpoint studies) involving NCE, Biologics and Generics. He has also been involved in organizing DSMB meets for NCEs wherein
he has acted as local medical monitor. He has been a Medical Advisor for new product development and involved in developing
medical rationales for new formulations.
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Our Key Site Oncologists

Gopi Chand

Gopi Chand is an Independent Hospital &
Health Care Professional at City Care
Center. He has completed his M.S., D.N.B.,
M.Ch., Surgical Oncology from Kidwai
Memorial Institute of Oncology

Dr Minish Jain

Dr Minish Jain is a Medical Oncologist at
Grant Medical Foundation, Ruby Hall Clinic.
He has completed his fellowship in Oncology
from P D Hinduja Hospital and Research
Center and pursed his research fellowhip
from Massachusetts General Hospital from
Boston.
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Dr Chirag Desai

Dr. Chirag Desai is one of the most dynamic
oncologists in India. He completed MD (Medicine) in
1991 and DM (Oncology) in 1993. He graduated in
the first batch of DM (Oncology) from Gujarat Cancer
and Research Institute (GCRI), Ahmedabad. He
started his oncology practice in 1999 and laid the
foundation of the group oncology practice that has
flourished today as HOC Vedanta with 11 colleagues
and 3 branches in Ahmedabad

Chandan Das

Chadan Das is a Medical Oncologist and
Associate Professor at PGIMER. He has
completed his post graduate in Medical
Oncology from Institute of Medical Sciences.
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Recognitions
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Recognitions L LN

~ I I
Celebrating Award Category

Best Clinical Research

Athﬂ 11204 Organization - India g
16 YEARS o BoS=7in Top CLRO Company
i Clinical Trial Company of the
I RE 5 ..
of excellence in AL - Best Quality Clinical
Clinical Research @"'”‘xmmmu Bharat Udhyog Ratan Award WProxsMedio Research Services in
T in Clinical Research India

Preuis e National Excellence Award Organization Award Category

m Best Pharmaceutical CRO . ..
— W'o Best Quality Clinical Research
Health & Safety Awards Best Clinical Research- India MRS+ Organization in India
L Best Clinical Research- India e Best Qua"t)_/ C|_inin’al| ReseaI‘Ch
.p = Organization in India

Mark of Excellence

Indian Clinical Research
company of the year

Indian Clinical Research
[ enoer o siiiicnn] company

of the year

Partners in creating a healthier tomorrow




P ..
o‘
ﬁ.‘
w”

Veeda Group Advantage

Extensive Scientific

Competence to service a One of the largest

Diverse client base Independent Full
Service CROs in India

High Customer %{é}ﬁ

Centricity and - '

Satisfaction Robust Quality &
Regulatory
Compliance

Skilled personnel with
focus on Continuous
Professional
Development One stop solution
for complex

studies
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Thank you

For any further assistance kindly write to us at info@veedacr.com
Visit us at www.veedacr.com
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